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Chapter 1 Introduction to MaPoss 
 
 

The impact collision problem is a geometrical, material and boundary conditions           
that are non-linear multi-physics field coupling problems involving high speed, high           
pressure, high temperature, phase change and chemical reaction, gas, liquid and solid            
and other substances between the coupling or even mixed, material will not only occur              
serious distortion and broken, but also melting or even vaporization. The Lagrangian            
method can easily track the boundaries of the material and the introduction of the              
material model associated with the deformation history, but for the problem of large             
deformation due to the serious distortion of the grid a numerical solution is difficult, and               
it is difficult to effectively simulate the material crushing, melting and vaporization and             
other acts. The Euler method does not ask for grid distortion problem, suitable for the               
analysis of large deformation and flow problems, but not easy to track the material              
interface, and non-linear convection items will lead to numerical difficulty in solving            
problems. 

 
By the particle grid method (particle in cell, PIC) inspired material point method             

(material point method, MPM) [1, 2] using Lagrange and Euler dual description (ALE),             
the object is separated into a group of particles in the space grid movement.  

Quality  
The point carries all the material information, such as quality, speed, strain and             

stress, and can easily track the material interface and A material model related to              
deformation history. The particles move in the space grid, and the equations of motion              
are solved on the spatial grid. The problem of grid distortion is suitable for the analysis                
of large deformation and flow problems. (The) Material point method fully absorbs the             
Lagrange law and Euler. The advantages of the method are one of the most promising               
methods for ultra-high speed collisions and numerical analysis of explosions. 

 
MPM3D® is the Computational Dynamics Laboratory of Tsinghua University         

(http://www.comdyn.cn) Professor of the research group since 2004 developed the          
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impact of the explosion three-dimensional material point method numerical simulation          
software (computer software copyright board Symbol for 2009SRBJ4761), can be used           
to simulate ultra-high-speed collision, shock, penetration and explosion problems. In          
order to facilitate further expansion, change, and maintenance, in summer of 2007, we             
rewrote the original FORTRAN 90 version of MPM3D using C++ MPM3D ®, of the              
MPM3D? Stop 
Only development, and as a monograph (Zhang Xiong, Lian Yanping, Liu Yan, etc.             
"Material Point Law", Tsinghua University Press, 2013),Supporting open source code,          
can be downloaded from the website http://www.mpm3d.com. 

 
The MaPoSS system is the result of the joint effort of the engineering             

department of the General Assembly Department and the Laboratory of Computational           
Dynamics of the School of Aeronautics and Astronautics, Tsinghua University,          
Developed, with MPM3D® as the core solver of the impact explosion numerical            
simulation system, which is based on Qt, VTK, CMake and 
C ++ development, with excellent cross-platform features, can run on Windows, Linux,            
Mac OS and other operating systems.MaPoSS is a job-oriented numerical simulation           
system. Jobs have the following attributes: 

 
1. Folder; Job's data file storage path, model data file and all output data The               
files are stored in that In the path. 
2. JobName; The name of the job, uniquely marked for the job. 
3. Header; Job title, the main user marked the job. The value of this property will                
be saved in the model data file In the Header element of the Header element. 
4.Description; A brief description of the job, such as the main physical            
phenomena of the problem, references, and so on. This attribute 
The value is stored in the description subelement of the Header element in the              
model data file. 
5. Job Units; The unit system used by Units Job. It has three components,              
respectively, the work of the time to define the time unit, Length units and mass               
units, which are stored in the model data file Unit sub-elements of the time,              
length and mass attributes. 
6. Model dataset; The dataset is a collection of model data for the job, including               
particle data, background grid data, 
Solution and result output strategy and other model data, the user can use             
MaPoSS graphical interface to the model data set to edit all model data. The              
model dataset inherits naming conventions from JobName, for example, model          
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data for a job named Rings, (the name shown in the Job Browser panel) is also                
named Rings. 
7. Model data file; model data file is to store all the attributes of the disk file, the                  
user can use The graphical interface of MaPoSS saves the attributes of the Job              
into the model data file, or the attributes of the Job from the model data 
Read into the MaPoSS system. Therefore, the model data file is actually a file              
corresponding to the job, which can be read by MPM3D® for simulation. The             
model data file is named after JobName. For example, named Rings Job, whose             
model data file is Rings.xmp, stored in the directory specified by the property             
Folder. 
 
The model data file is in standard XML format and can be used with any XML                

editor or text editor to edit. MaPoSS has built-in QXMLEdit and has modified the editor               
so that it can be loaded MPM3D® material library, and can call MPM3D ® its current                
editing data files for simulation.  

MaPoSS allows you to create or load multiple jobs, which are listed in the Job               
Browser panel. Users can use the mouse or keyboard to select a job in the Job Browser                 
panel and edit all the attributes of this job, Save this Job (save to file               
/Folder/JobName.xmp), you can also directly edit the model data file for this job 
(/Folder/JobName.xmp) and call MPM3D® to calculate the simulation for this Job. 

MaPoSS system with pre-processing (Models menu), simulation calculation and         
monitoring (Simulation menu) two functions, Postprocessing is done using ParaView.          
ParaView is made by Kitware Corporation, Los Alamos National Laboratory, An open            
source multi-platform data analysis and visualization developed jointly by the Sandia           
National Laboratory and CSimSoft Inc. Application, can be ultra-large-scale data          
analysis and processing, can run on the desktop, can also run on the parallel computing               
platform 
on. 
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Chapter II Pre-Processing System 
 

PeneBlast system pre-processing functions mainly through the menu bar, task list area            
and data set attribute area to complete. The user can interactively edit the attributes and               
model datasets of the Job, such as creating geometric entities with regular shapes and              
user self 
Define geometric entities, set background grids and various types of solver parameters,            
and export Job attributes and model datasets to model numbers According to the file              
(extension xmp), read for MPM3D® to solve. Pre-processing system interface includes           
five sections, namely the menu bar, task list area (Job Browser), data set 
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Job Properties, GUI real-time display area, and real-time monitoring area. PeneBlast           

pre-processing system interface tour 
Figure 2.1 shows the figure. 

 
 
 
 
 

 
 

2.1 Pre-processing system functions and process overview 
 

2.1.1 Pretreatment System Function Description 
Each submenu in the menu bar contains all the pre-processing action buttons, which             
can be edited interactively by these menus job attributes and model data sets, to              
complete the pre-processing settings and operation. The following describes each          
drop-down menu function: 
 

● File 
File submenu (Figure 2.2) can complete the file, task-related operations. 
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● New Job 
Create a new task to solve the task, while the task list will be automatically               
numbered new tasks, the user can click on the Job 
The Job Name edit box in Properties changes the name. 

● Open Job 
Open Job function, unlike the Load Job, only adds the specified job to the Job               
Browser list, The PeneBlast system does not read the actual content of the xmp              
file. After selecting the job, you can edit its xmp text 
Pieces, check the xmp file format, call MPM3DPP to calculate, view the log file. 

● Load Job 
Import the task, according to the pop-up file dialog box (Figure 3.1), import the              
specified path under a pre-processing model data text (.xmp file), the           
pre-processing system will load the corresponding parameters, while the model          
displayed in the GUI real-time display area in. The file holds all the information              
entered in the pre-processing interface, which is processed by the "Save Job"            
menu of the preprocessing system generated by the user can also use the text              
editor to generate their own, you can import the pre-processing interface for            
users to check model and reset. 

● Save Job 
Save the current model's status to the current path (the path shown in the Folder               
box in the Job properties panel path), specify the name (the name shown in the               
JobName box in the Job properties panel) in the xmp format In the file. 

● Save Job As 
Save the task, according to the pop-up dialog box (Figure 2.4) (translator note:             
figure omitted typical “save-as” dialog) )the current task to specify the name (*             
.mlb) to the specified In the path. 

● Save Screenshot 
Screenshot function, according to the pop-up dialog box (Figure 2.5), the GUI            
real-time display area image copied to the specified path. 

● Exit 
Exit the PeneBlast system. 

● Edit 
The Edit submenu (Figure 2.6) allows you to delete the Job function and make              
the relevant settings. 

● Delete 
Deletes the currently selected job 

● Delete All 
Delete all jobs in the task list area 

11 
 
 
 
 



 

● Setting  
Set the working path and the text editor, ParaView executable file, text            
comparator path, click "Apply" Button to complete the setting, as shown in Figure             
2.7. 

 
● View 

The View submenu option (see Figure 2.8) performs a variety of view operations             
on the GUI real-time display area. 

 
● Camera 

Reset - Center all live to the GUI real-time display area 
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+ X, -X, + Y, -Y, + Z, -Z- Set the direction of the observer to X-axis positive,                  
X-axis negative, Y-axis forward, Y-axis negative, Z-axis positive, Z-axis negative. 

● Show Orientation Axes 
Whether the global coordinate frame is displayed in the GUI real-time display            
area 

● Show Center 
Whether the global origin is displayed in the GUI real-time display area 

● Models 
Models submenu (Figure 2.9) can complete the material definition, create a new            
component, create a new geometry with regular shape (Block, Cylinder, Ogive,           
Sphere) and user-defined geometric entities (User-Defined). 

 
● Material 

Define the material for the current task. For details, see Section 2.3. 
● Create Component 

New components, the current task of the new components will be automatically            
numbered, the user can double-click the task list area on the component name 
To modify the component name. 

● Create Block 
Create a new block. For details, see Section 2.5.1. 

● Create Cylinder 
New generalized Cylinder (regular rotation), see Section 2.5.2 for specific          
operations. 
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● Create Ogive 
Create a new Ogive, see Section 2.5.3 for specific operations. 

● Create Sphere 
Create a new Sphere, see Section 2.5.4 for specific operations. 

● Create User-Defined 
The new user imports the 3D solid model (stl format). For details, see Section              
2.5.5. 

● Create User-Defined 
Create a new user-defined geometry entity. For details, see Section 2.5.6. 

 
Simulation 
The Simulation submenu (Figure 2.10) completes the check, edit, and start of the             
current xmp file format and other functions. 

 
●  Check Input Data 

When the task the format is wrong before the xmp file generated by the format               
check, and give the test results - pop-up dialog box (Figure 3.2), given the              
specific error message; format is correct pop-up dialog box (Figure 3.3) prompt            
format check Check through. 

● Edit Input Data 
Call the text PeneBlast system comes with the editor QXmlEdit on the former             
task generated by the xmp file Series, modify and other operations, as shown in              
Figure 2.13. 
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● Start 
Call the MPM3DPP program to start calculating the current task. 
 

● Real time monitor 
Whether real-time display of the calculation process is enabled in the GUI 
real-time display area. 

Test 
The Test submenu (Figure 2.14) is used to complete the study file in the standard study 
database TestDatabase (xmp Format) of the calculation test function. Users click the 
Test button that pops up MPMTest dialog box (Figure 2.15), the user can As needed to 
detect all or part of the xmp file under the specified path to observe the results of the 
latest MPM3D calculation program And the standard study database TestDatabase in 
the results of the document is consistent. 
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Test directory interface (fig 2.15), specifies the need to detect the xmp file sitting              
in the location (path); Output directory Specify the result output path to calculate the              
test; the "Search" button is used to search all the xmp files under the Test directory, And                 
the list is displayed; the "Select" button is used to select all or all of the xml files in the                    
list box; 

 
Click the "Test" button to start the calculation of the selected xmp file test; click               

"Stop" button to stop the test; point Click the "Close" button to exit the calculation test                
and close the MPMTest interface dialog box. Among them, the list box "Status" gives              
the results of each study to calculate the test and the standard study database Test-               
Database in the results of the file comparison, if the two results are consistent,              
otherwise displayed. 
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● About 
Given the PeneBlast system profile, R & D team, release log and other             
information. 

● PeneBlast User's Manual 
View the PeneBlast User Manual 

● MPM3D User's Manual 
View the MPM3D User Manual 

● MPM3D Theory Manual 
View the MPM3D theory manual 

● MPM3D Example Manual 
See the MPM3D study manual 

 
 
2.1.2 Preprocessing Process Overview 
 
The ultimate task of a typical pre-processing process is to generate a mass-value             
simulation program MPM3DPP read the solution of the data file (extension xmp),            
therefore, the pre-processing work mainly includes the following steps: 
1. New solution task; 
2. Define material - New material model, or import material data directly from existing              
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libraries; 
3. New components in the pre-processed data set (PreDataSet); 
4. Create a new geometry under the various components - the new conventional             
geometric entities (Block, Sphere, Cylinder, Ogive) And it is in the form of a discrete               
form of material points; or directly from the third party CAE software into the built a few                 
what information is scattered. 
5. Set the attributes of the pre-processed data set - set the work plane, background grid                
information, contact control, definition 
Burst point (face), solution options, output settings. 
6. Save the specified job, output the pre-processing task file - generate the mass point               
for the simulation program MPM3DPP read 
Solve the data file (extension xmp). 
7. Calculate the operation, call the material point value simulation program MPM3DPP,            
start calculating the new task (file extension 
xmp). 
 

 
 
 
 

2.2 The ‘New Solution’ Task 
 
Function: the new task to solve the task, specify the task file (*. Xmp) output path to                 
solve the task named ‘JobName’, A brief description of the tasks is made, and the unit                
system of the three basic dimensions (quality, length, time) of the pre-processing set is              
set. 
The new solution task is as follows: 
1. Click "New Job" on the File menu to automatically create a Job in the Job List area 
And its corresponding PreDataSet; 
2. Click to activate the current task of the task list area, in the bottom of the Job                  
Properties column will pop up the task settings panel (as shown in Figure 2.17); 
3. Select the storage path "Folder" of the new task. This field is required. The default                
folder is "installation path / data / work" The default path can be changed by clicking the                 
"Browser" button; 
4. Specify the task name "JobName", the user changes the default name of the task will                
be displayed in the task list synchronization, This field is required, the file name of the                
output xmp file is "JobName.xmp"; 
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5. Add the task title "Heading" (which lists the attributes such as the classification of the                
problem) and the task description "Description" 
The problem is briefly described, the content will be written to the xmp file comments);               
"Heading" and "Description" also can not fill 
6. Select the unit used in this task - by selecting the "Mass" "Length" "Time" checkbox 
Bit, to specify the unit system used. Among them, the mass mass of the optional units                
for the mg, g, kg, length. The optional units of the Length dimension are mm, cm, m,                 
and the optional units of the Time Time dimension are s, ms, s; The unit of acceptance                 
is mg-mm-ms. 

 
The JobBrowser panel shows the only corresponding data set for the job and the              
components and geometries contained in the dataset type. For each Job, its name, the              
selected unit system, xmp file name and storage path, etc. can be modified First select               
the mouse with the need to modify the task list area of the Job, by modifying the                 
following Job Properties column settings board corresponding options, you can          
complete the corresponding edit box parameters of the changes, update. At the same             
time, click on the corresponding data set (PreDataSet), you can in the bottom of the               
pre-processing data set attribute area (Job Properties) to see each PreDataSet contains            
WorkPlane, Grid, Contact, Detonation, Solution and Output six properties tab (Figure           
2.18), activate these property pages can be completed work plane set Meaning,            
background grid settings, contact control, definition of the starting point (face), solution            
settings, output options and other operations. 
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2.3 Material definition 
 

PeneBlast has two ways to provide material data to the current task - to create new                
materials and to load existing materials. Simultaneously, Users can copy or modify the             
material in the material library (model and parameter values can be modified), and             
modify the results as New material data is stored in the user-specified library. Each              
material has a name, density, EOS type, strength mode type, failure model, and             
parameter source. 
1. By creating, loading, modifying, copying, deleting, saving, viewing and other           
operations, the new definition of this task will be used Material model and the              
corresponding data, and the name of the new material listed in the material list. 
2. PeneBlast will be commonly used material data entry, stored in an existing library              
(extension mlb), storage 
The path is "installation path / bin"; users can choose to use a material directly from the                 
library and import it into the current task, the imported material name will be displayed in                
the material list. 
Use the process description: 
To define a material for a current task, use the New, Load, Modify, Copy, delete, save,                
review, library, and other buttons, perform the appropriate action to complete the            
material definition work in the task. Click "Material" on the Models menu to pop up               
material definition dialog (Figure 2.19) to start the new material. 
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The function and operation method of each function key are as follows: 
 
2.3.1 New Material 
Function: Create new material and set material parameters. 

Operation flow: click on the material definition interface on the New, pop-up 
"Material Data Input" dialog box (Figure 2.20) Show the name, density, intensity model, 
state equation, failure model, and parameter source of this material. Different strength 
modes, type, state equation, failure model has different parameters, the program will be 
based on the selected model to start a different parameter definition box. 
The parameters used for each model can be found in the "MPM3DPP User's Manual". 
Click on the interface with press button to shrink / expand the corresponding parameter 
box. When you click Apply, the system will automatically check all the required options 
are filled out. As long as Material Data Input If the required parameters of the interface 
are not filled in, click Apply will pop up the error box. Before the required option is not 
filled in, 
In front of the show, waiting for the user to fill in; fill in the required fill in the key to 
confirm, then become. 
Note: The material definition interface, all the parameters of the units have been given a 
clear, the user input the corresponding variable value must be fine, It is converted to 
match these units on the interface. In normal calculations, the PeneBlast system 
automatically converts these values into the user selected unit system to match the 
value of the variable to calculate 
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2.3.2 Load 
Function: Import the existing material model and the corresponding parameters directly 
from the default (specified) library. 
 
Operation flow: Click the Load button on the material definition interface to pop up the 
"Load Material Model" window Figure 2.21), which lists the strength of the material in 
the system library, the state equation, the failure mode Type, the default path for the 
library file is "X: Install folder / Tsinghua University / PeneBlast / bin". through 
Over the mouse click to select a material (highlight the material at the same time), click 
the Load button, you can select the material included n the material list; you can click on 
the multiple material, click the "Load" button to load this one at a time Materials, and 
finally click Ok button to confirm. 
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2.3.3 Modify 
Function: Modify the parameters of the material selected in the material list (shown in 
Figure 2.22). 

 
Operation flow: first select the material list box in a material (highlighted, as shown in 
Figure 2.22), then click Modify Pop-up material parameters dialog box (shown in Figure 
2.23 ), modify the variable parameter value, or change the material strength model, the 
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state enter the new variable value, click Apply to save the changes, close the dialog 
box. 

 
 
2.3.4 Review 
Function: View the parameters of the selected material. 
Operation flow: first select the material list box in a material (highlighted, as shown in 
Figure 2.22), then click Pop-up material parameters dialog box (Figure 2.24), then all 
the material parameters are gray, the user can not modify, click the Cancel off 
Close the dialog box. 
2.3.5 Copy 
Function: Copy the selected material from the list of materials into a new material. The 
new material is named "raw material name -ewew". 
Process: Click Button, in the material list box to create a new material, the new material 
to copy all the raw materials Type and parameter values, named "raw material name 
-new", as shown in Figure 2.25. 
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2.3.6 Delete 
Function: Remove the selected material from the material list box. Operation flow: first 
select the material list box in a material (highlighted, as shown in Figure 2.22), then click 
Button to complete the operation from the material list to remove the material. 
2.3.7 Save 
Function: Save the selected material in the material list to the specified material library. 
Process: Click 
Button, pop-up Save Materials dialog box, as shown in Figure 2.26; selected (multiple 
choice)Material in the box (highlighted), and then specify the material into the material 
library (the current database, the existing 
His database and the new database), click Apply to complete the follow-up, click 
Finished to exit.The default option saves the material information in the current library 
Current library (Figure 2.19 shows the current material 
The current path of the library); if selected into the existing material library Existing 
library, the bomb File dialog box (Figure 2.27), select the specified path under the library 
file, click the "open" button to store the material Into the specified library file; if you 
choose to save the new library New library, the pop-up dialog box, specify the road 
Diameter, name the name of the new library (the program automatically adds the file 
extension "mlb"), the operation interface shown in Figure 2.28, the operation into After 
the pop-up prompt box (Figure 2.29) prompted the material into the success. 
 
2.3.8 Library 
Function: Select the library file required for the current task, and the Load operation will 
be from the library file specified by Library Loading material. 
 
Process: Click  Pop-up Select Material Library File dialog box, by specifying the path, 
select The material library file for the current task, click Ok to select the library, the 
PeneBlast system sets it as the material and displays its path in the "Current Material 
Library Path" property box (see Figure 2.30). 
 
2.4 New components 
Function: Create a new component under the current dataset. 
Process: Click the PreDataSet to activate the Job List Job, and then click the menu bar 
Models option (see Figure 2.9) In the "Creat Component", you can in the current job 
pre-processing data set below a new component (default name component1, the new 
multi-component system automatically numbered in order, the user can double-click the 
entry to modify the name), such as As shown in Figure 2.31. Shortcut - the user can 
right click on a Job's PreDataSet, right click pop-up menu You can create a new 

25 
 
 
 
 



 

component, as shown in Figure 2.32. Click Activate the component to repair it in the 
Component Properties area Change the Component property page. 
 
Component has three property pages in the Job Properties area (Figure 2.33): 
Properties, Display, and Fill, used to display the properties of the Component (Body 
list), display mode and fill material, load the initial conditions.  
 
Properties page The Properties list displays all the bodies contained in the 
Component. 
Property page Display and Body Display property page is roughly the same, but this 
time through the "Bg color" to repair Change the background color of the GUI real-time 
display area. The property page Fill (Figure 2.34) is used to fill the material of the 
Component as a whole, All of the Body is filled with a material that loads some sort of 
initial speed. Select Material, Velocity, or Adaptive split, you can modify all the 
components within the Body of the corresponding attributes, and finally click Apply, the 
selected attributes will be applied to All of the components in the Component. 

 
(translator’s note: Fig 2.34 was blank in original manual) 

PeneBlast's contact algorithm handles contact between components, rather than         
between objects. The component name specifies the substance Which component          
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belongs to. A component consists of multiple bodies. The xmp file uses the component              
number (starting at 1) to define the group, The PeneBlast system automatically converts             
the component names into the component numbers in order when the xmp file is output. 

 

        2.5 Create a geometric entity 
 
Create a new geometry entity (Block, Cylinder, Ogive, Sphere, User-Defined) in the 
current component and set Its attributes (space position, geometry, work plane, fill 
material, object density, initial speed, load setting, display Display format, particle 
spacing, discrete mode, etc.), see MPM3D User's Manual. For MPM3DPP program The 
existing body type (Block, Cylinder, Ogive, Sphere), in the xmp file output the body of 
the space Location, geometry and particle spacing, etc .; for the User-Defined type, 
PeneBlast system in accordance with the input file The body will be separated into the 
material into the particle, and then MPM3DPP Point format will be discrete particles 
after the particles The information is written separately as a file output. All of the newly 
created objects belong to a selected component in the current preprocessing dataset 
and are listed in the order in which they were created The following. body created, you 
can in the Job Browser interface (Figure 2.31), double-click to change the body name, 
right-click delete Except the body. The interface for creating objects is shown in Figure 
2.35. 
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Operation flow: in the Job Browser in the current PreDataSet selected components            
below the current Body name (The user can double-click the entry to modify the name),               
PeneBlast system according to the type of body to show the Body Preview and define               
the way. For each Body (Block, Sphere, Cylinder, Ogive, etc.) under Component, Job             
Browser below the Body Properties column contains the body of the four property pages              
(Properties, Load 
Setting, Display, Discretization). The user can define the size of the Body and its              
properties in the Properties property page It is related to the properties until the              
completion of the definition of the operation of the geometry. 
 
 
2.5.1 Block 
Function: New cuboid. 
Properties page As shown in Figure 2.36 
• (x0, y0, z0) 
Defines the spatial location of Block. The space coordinate value is relative to the              
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loaded WorkPlane if Block is not loaded Into any WorkPlane, this set of spatial              
coordinates that define the location of the Block in the global coordinate system. 
 

 
• x length, y length, z length 
Defines the geometry of the Block 
• WorkPlane 
Defines the WorkPlane that Body needs to load. For the definition of WorkPlane, see              
Section 2.6.1. 
• Material 
Defines Body-filled material 
• Body density 
Define the current density of the body, which is inconsistent with the density of the               
material used. In a state of compression or expansion. 
• Adaptive Split 
Used to set the adaptive splitting factor 
• Velocity defines the initial speed of the Body, as determined by the Initial velocity and                
Prescribed Velocity Fill in value. Initial Velocity is used to set the initial speed of the                
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current object: 
 
V_x: Sets the speed of the object in the x coordinate direction 
V_y: Sets the speed of the object in the y coordinate direction 
V_z: Sets the velocity of the object in the z-coordinate direction 

 
Prescribed Velocity is used to set the constant velocity of the current object. At any               
time, the object is given a constant speed The degree of movement. If the constant               
velocity value specified for the object is 0, the object corresponds to a fixed rigid body.                
The element 
Has the following attributes: 
 

● V_x: Sets the constant speed of the object in the x coordinate direction 
● V_y: Sets the constant velocity of the object in the y coordinate 
● V_z: Sets the constant velocity of the object in the z-coordinate direction 

 
 
Load Setting page 
The Load Setting page (Figure 2.37) is used to set the Load properties of the Body 
• PrescribedAcceleration Set the time course of the load, the current body with the time               
to load the load f_i = A_i x a_i. (About MPM3D For a further description of the time                  
history load, see the MPM3D User's Manual.) 
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● ax: Sets the magnitude of the acceleration of the object in the x coordinate              
direction 

● ay: Sets the magnitude of the acceleration of the object in the y coordinate 
● az: Sets the acceleration amplitude of the object in the z-coordinate direction 
● arx: Sets the angular acceleration of the object in the x coordinate direction 
● ary: Sets the angular acceleration of the object in the y coordinate 
● arz: Sets the angular acceleration amplitude of the object in the z coordinate             

direction 
 

Coefficient: used to define a certain time the acceleration multiplied by the coefficient;             
the element has the following seven attributes: 

 
1. time: set the time; 
2. cx: sets the coefficient of ax; 
3. cy: set the coefficient of ay; 
4. cz: set the coefficient of az; 
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5. crx: sets the coefficients of arx; 
6. cry: Sets the coefficient of ary; 
7. crz: set the arz coefficient; 
● HarmExcit (HarmonicExcitation) - Set the harmonic excitation load, the load          

function form is as follows: 
 

    sin(ωt )f = A + θ  
 

And can control the frequency of the load applied in each direction, the phase angle and                
the action time. The element has three child elements, Each element has three             
attributes, namely x, y, z. The details are as follows: 
 

● Omega: sets value of the harmonic stimulus applied in the three directions of x, y,               
z;  

● Theta: sets the value of the harmonic stimulus applied in the three directions of x,               
y, z; 

● EndTime: sets the stop time of the harmonic stimulus applied in the three directions              
of x, y, z; 

 
ConstrainRigidPosition 
Set whether the rigid body moves at the specified speed and load. 
When the rigid body in accordance with the specified movement law movement, if the              
collision with other objects are not affected, other objects are subject to 
Rigid body effects 
 
Display page 
The Display page (Figure 2.38) is used to set the display properties of the Block 

● Visible 
Whether the object is displayed 

● Zoom to data 
Button to scale the body in the best size to the GUI real-time display area               
centered 

● Surface color 
Defines the display color of the object's surface 

● Edge color 
Defines the display color of the edges of the object. 
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● Point color 
Defines the display color of the object corner. 

● Representation 
Defines the rendering of objects (Surface, Wireframe, Surface with edge,          
Points). 

● Line width 
Defines the width of the lines in the Wireframe and Surface with edges 

● Point radius 
Defines the display radius of the corner point. 

 
 
 
Discretization page 
 
The Discretization page (Figure 2.42) defines the particle's discrete approach to the            
block. 

● dp 
Block using orthogonal isometric coords, so we only need to specify a direction of              
the particle spacing dp can be. 
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2.5.2 Cylinder 
Function: Newly used regular rotating body, including the cylinder, cone, round table, 
the model of the schematic diagram shown in Figure 2.40 illustrates. 
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Properties page 
As shown in Figure 2.48 
 

● x0, y0, z0 - Defines the spatial position of the Cylinder starting point. The space                
coordinate value relative to the loaded WorkPlane, ifCylinder does not load any            
WorkPlane, this set of spatial coordinates that defines Cylinder in the global            
coordinate systems position. 

● r0 - The cylinder inner diameter of the starting face 
● R0 - The cylinder outer diameter of the starting end face 
● r1 - Cylinder ends the inner diameter of the end face 
● R1 - Cylinder ends the outer diameter of the end face 
● L - The axial length of Cylinder 
● Angle - Defines the angle of rotation 
● Workplane, Material, Body density, Adaptive split, Velocity -The meaning of          

the these edit box parameters is the same as in aforementioned Section 2.5.1             
properties, not repeat here. 
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Load Setting page 
The meaning of the edit box parameters in the Crowinder's Load Setting tab is the same                
as described in Section 2.5.1, Load Setting page. 
 
Display page 
The meaning of the edit box parameters in the Cylinder's Display tab is the same as in                 
Section 2.5.1 Display page. 
 
Discretizaion page 
The Discretizaion page (Figure 2.42) defines the Cylinder's Discrete approach. 
 

● dp bottom - specifies the particle spacing of the starting end of the Cylinder 
● dp top - specifies the particle spacing of the end face of Cylinder. 

dp bottom, dp top After the determination of the layers along the height direction              
(Z axis positive direction) of the particles, the spacing by the ratio 
Relationship changes. 

● dp Discretization - discrete mode, the value of 0 or 1: 0, orthogonal way of               
distribution; 1, the way to the distribution point. 
Due to the geometrical characteristics of the rotating body itself, the use of a              
circumferential distribution (as shown in Figure 2.43) can better keep the rotating            
body geometric shape. 
 

○ If the Angle property of Cylinder on the Properties page is not 90, or 180,               
or 270, or 360, PeneBlast The system only supports loopback 

 
 
2.5.3 Ogive 
Function: New oval body, the default warhead direction along the Z axis positive 
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direction. 
Properties page As shown in Figure 2.44 

● x0, y0, z0 - Defines the spatial location of the Ogive starting point. The space 
coordinate value relative to the loaded WorkPlane, if Cylinder Does not load any 
WorkPlane, this set of spatial coordinates that define the Cylinder in the global 
coordinate system in the bit set. 

● R_end - The end radius of the oval body. 
● R_og - Ogive Radius of oval body. 
● Angle - Define the opening angle of the new oval 
● Workplane - Material, Body density, Adaptive split, Velocity 

The meaning of the above edit box parameters with the aforementioned Section            
2.5.1 Properties page, not repeat here. 
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Load Setting page 
The meaning of the edit box parameters in the Ogive Load Setting tab is the same as                 
described in Section 2.5.1, Load Setting 
page. 
Display page 
The meaning of each edit box parameter in Ogive's Display tab is as described in               
Section 2.5.1 Display page. 
Discretizaion page 
The meaning of the edit box parameters in the Discretizaion tab of Ogive is the same as                 
that described in Section 2.5.2 Discretizaion page. 
 
 
2.5.4 Sphere 
Function: New sphere. Properties page As shown in Figure 2.45. 

● x0, y0, z0 
Defines the spatial position of the sphere. The space coordinate value relative to             
the loaded WorkPlane, if Cylinder does not load any WorkPlane, which defines            
the position of Cylinder in the global coordinate system. 

● Radius outer 
Ball outside diameter. 

● Radius inner 
Ball inside diameter. 

● Angle -The angle of the two semicircular surfaces of the ball - type rotating body. 
● Half - This property is only available when Angle = 90. When Angle = 90 check                

the property that whether to take the 
1/4 of the upper part of the ball: that is, half = 0, to generate a quarter ball; when                   
half = 1, take the first half of the quarter points, that is generated within the first                 
divination limit of 1/8 ball. 

● Workplane, Material, Body density, Adaptive split, Velocity 
The meaning of the above edit box parameters with the aforementioned Section            
2.5.1 Properties page, not repeat here. 

Load Setting page 
The meaning of the edit box parameters in the Load Setting tab of Sphere is as                
described in Section 2.5.1, Load Setting page. 
Display page 
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The meaning of the edit box parameters in the Display tab of Sphere is as described in                 
Section 2.5.1 Display page. 

 
 

 
Discretization page 
The Discretization page (see Figure 2.46) defines the particle's discrete approach. Due            
to the geometric properties of the sphere itself. The ball can be discretized in different               
ways, such as the orthogonal distribution (Discretization = 0) and the directional            
(Discretization = 1). Orthogonal distribution in three mutually perpendicular directions          
(ie, along the x, y and z axes) pairs.The sphere is orthogonal to the dispersion, and the                 
way of the distribution of the ball along the spherical coordinate system of the three               
coordinate axes on the direction of the ball to the equidistant distance Scattered, this              
way can be better to keep the spherical surface. 
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● dp - Sphere no matter what kind of distribution method, only need to specify a               
reference particle spacing dp can be. 

 
 
 

 
 

2.5.5 Polyhedron 
Function: Create a new entity of the 3D geometry model represented by the .stl file.               
Properties page As shown in Figure 2.47. 

● x0, y0, z0 - Defines the spatial position of the polyhedron. The space coordinate               
value is relative to the loaded WorkPlane if the polyhedron is not loaded 
Into any WorkPlane, this set of spatial coordinates that define the polygon in the              
global coordinate system position. 

● Scale - Defines the scale of the imported model 
● Workplane, Material, Body density, Adaptive split, Velocity 

The meaning of the above edit box parameters with the aforementioned Section            
2.5.1 Properties page, not repeat here. 

Load Setting page 
The meaning of the edit box parameters in the Polyhedron's Load Setting tab is the               
same as described in Section 2.5.1, Load Setting page. 
Display page 
The meaning of each edit box parameter in Polyhedron's Display tab is as described in               
Section 2.5.1 Display page. 
Discretization page 
The Discretization page (Figure 2.48) defines the polygon discrete approach. As the ball             
is introduced into the three-dimensional geometry body is often more complex, can not             
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use a unified formula for discrete point coordinates calculation, so here the use of              
geometric uniform inside and the external use of ball filling algorithm based on the              
layout of the program, this approach can ensure that the internal discrete uniform, but              
also can be better to maintain the polyhedral surface. 

● dp global 
Defines the reference value of the global discrete point spacing, and the actual             
spacing may fluctuate up and down at this distance 

● Test Solidfill 
Click this button to save the discrete effect before saving the job (if the model               
geometry is changed, you need to click this again Button to discrete, save the job               
does not automatically discrete operation), discrete data exists button left edit           
box 
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2.5.6 User-Defined 
Through the third-party CAE modeling software, to construct complex geometric          
entities, and discrete into a finite element mesh form (head before only supporting the              
eight-node hexahedron unit), the Grid2Point tool of the PeneBlast system is           
implemented by importing software from CAE. A file containing the entity node and cell              
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information generated to generate a text file containing material point information.           
PeneBlast. The system creates new complex shape geometry by importing the text file             
containing the substance point information. 
 

 
 
Properties page 
As shown in Figure 2.49 

● File 
Specifies the path of the text file that contains the substance point information. 
The text file containing the substance point information lists all the mass            
information contained in the entity,  

○ the first column: the material quality. 
○ The second to fourth columns are the spatial coordinates x, y, z of the              

material point.  
 
 
The format is as follows: 
1.0079665e + 000 0.0000000e + 000 0.0000000e + 000 0.0000000e + 000 
9.3025750e-001 3.4641000e + 001 2.0000000e + 001 0.0000000e + 000 
1.8897898e + 000 1.7321000e + 000 1.0000000e + 000 0.0000000e + 000 
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... 
5.2774400e + 000 1.5385000e + 001 1.7252000e + 001 0.0000000e + 000 

● Material, Body density, Adaptive split, Velocity 
The meaning of the above edit box parameters with the aforementioned Section            
2.5.1 Properties page, not repeat here. 

 
Load Setting page 
The meaning of the edit box parameters in the Load Setting tab of User-Defined is as                
described in Section 2.5.1 Load Setting page. 
 
Display page 
User-Defined Display tab of the edit box parameters in accordance with the above             
Section 2.5.1 Display page description fill write. After the parameters are filled in, click              
Apply, the GUI real-time display will show the imported entity, as shown in Figure 2.50 
When the system creates a file containing the geometric information for all the material              
points of the disc under the Job storage path of the task. 
 

 
Figure 2.50: GUI Graphical Area Real-time  
display of user-defined geometry entities 

 
 

2.6 Set the properties of the pre-processed data set 
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The Job Properties of the Preprocessing Data Set has the property pages WorkPlane,             
Grid, Contact, Detonation, Solution and Output, used to set the local work plane             
parameters, background grid information, contact control, the definition of the starting           
point (surface), output options, solution settings. In the Job Browser, click on a             
preprocessing dataset in the list to preprocess the dataset. The PreDataSet Properties            
will display the property pages WorkPlane, Grid, Contact, Detonation, Solution and           
Output. 
 
 
2.6.1 WorkPlane property page 

WorkPlane property page (shown in Figure 2.51) for the user to enter the             
specified parameters used to define a set of local coordinate system, The user             
establishes the Body model in these local coordinate systems. In MPM, the coordinates             
of the particle points are in the global coordinate system definition, and for the body               
loaded WorkPlane, the initial position parameters (x0, y0, z0) of the reference system Is              
a local work plane. In order to achieve a variety of Body rotation and translation               
operations, the need to introduce the work plane will be the body. The discrete particles               
are moved from the local system to the global coordinate system. In the local coordinate               
system to establish the body discrete, 

The use of local work plane can be used to complete a single operation of the                
various body rotation and translation, the Body moved to the air between the specified              
location. Load the WorkPlane on the Body to get the location of its particle points in the                 
global coordinate system. 
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● "Add" button 
Create a new set of work planes. 

● "Delete" button 
Deletes the currently active set of work planes. 

● "Apply" button 
Save all the parameters in the current WorkPlane list. 

 
Each work plane contains the following four sets of information: 

● Name 
WorkPlane name, each new new work plane, the default name will be            
automatically numbered, the user can double-click the default name of the edit            
box, modify the new name. 

● r0x, r0y, r0z 
The offset of the origin of the WorkPlane relative to the origin of the global               
coordinate system 

● ex, ey, ez 
The Z-axis vector of the local coordinate system (WorkPlane) is in the direction             
vector of the global system 

● a11, a21, a31 
The X-axis vector of the local coordinate system (WorkPlane) is in the direction             
vector of the global system. 

 
Precautions: 
(1) vectors (ex, ey, ez) and (a11, a21, a31) are used to specify the Z-axis (main                
direction) and X-axis of the local coordinate system, respectively. The amount of square             
under the global system, do not require a unit vector (that is, not required) 

 and  (optional)  √e2
x + e2

y + e2
z = 1   √a2

11 + a2
12 + a2

13 = 1  

but what is required is that the two directions are vector orthogonal, i.e., that  
 

(required)a a a    ex 11 + ey 12 + ez 13 = 0  
 
must be strictly satisfied. If the body Loaded this illegal work plane, will pop up the error                 
box as shown in Figure 2.52. 

47 
 
 
 
 



 

 
 
(2) The Y-axis direction of the local coordinate system is automatically obtained by the              
vector (ex, ey, ez) by the vector (a11, a21, a31), such that the WorkPlane's coordinate               
frame is still maintained for the right hand system. 
 
2.6.2 Grid property page 
 
The Grid property page (Figure 2.53) is used to set the background grid parameters,              
including the basic grid parameters, moving the grid and moving state grid settings. 

● x0, x1, y0, y1, z0, z1 
Define the background grid area for solving the problem. 

● Boundary Type 
Set the boundary conditions of the boundary plane, can be set to (Free / Fixed /                
Symmetric / Transmit / Rigid Plane), points Do not match (0/1/2/3/4): 
 

● boundary = "0" - free boundary interface; 
● boundary = "1" - fixed boundary, constrains all the degrees of freedom of the              

boundary node; 
● boundary = "2" - symmetric boundary, constraining the normal motion of the            

boundary node, the other two directions free; 
● boundary = "3" - transmission boundary surface, that is, without reflection           

boundary conditions; 
● boundary = "4" - rigid surface, the boundary node can not penetrate the             

boundary in the normal direction, the other direction free. 
● dcx, dcy, dcz 

x, y, z in the three directions of the initial grid spacing 
● Mass cutoff 

Set the minimum node quality cutoff coefficient c, the default value for the system              
can represent the minimum error DBL_EPSILON Or FLT_EPSILON. (See         
"MPM3DPP User's Manual"); 

● GIMP 
Whether to use GIMP algorithm 
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● Consider Loss Particle 
Set whether or not the dead particles are included in the area where the mass               
point is counted. If checked, it means that the invalid particles are counted and              
unchecked 
That does not count into the failure of particles. The default is not counted as               
invalid particles. 

 
 

● Time step factor 
Set the mobile grid interval step factor factor. Taking into account each step to              
determine whether to move the grid to spend more time, 
So move the grid by calculating how many steps are predicted. The program             
multiplies the calculated number of steps by factor 
The value obtained by dt scale is the number of interval steps that are actually               
used in the program. factor The default value is 0.8. 

● XMin 
Sets the x-direction minimum moving boundary of the moving grid 

● XMax 
Sets the x-direction maximum moving boundary of the moving grid 

● YMin 
Sets the y-direction minimum moving boundary of the moving grid 

● YMax 
Set the y to the maximum moving boundary of the moving grid 

● ZMin 
Sets the z-direction minimum moving boundary of the moving grid 

● ZMax 
Sets the z-direction maximum moving boundary of the moving grid 

● Clear cell step 
Sets the number of steps to clear the original grid and node instances. Every              
time a certain period of time to clear the original grid and An instance of a node                 
that is rebuilt when used to save memory. The default time interval is 10, if the                
value is set 
Is less than or equal to 0, it means never clear. Valid only if Dynamic cell is                 
checked. 

 
2.6.3 Contact property page 
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● Contact on 
Whether to enable contact, only check the Contact on when the following options             
are available (Figure 2.54), if the number of components is 1 The touch algorithm              
is not enabled. 

● Failure to component 
Whether to enable particles as a standalone component after failing, the default            
is not enabled. After the activation, the failed particles as 
The relationship between individual components and other components is         
calculated using the contact algorithm. 

● Exclude components 
Sets whether or not to exclude components that have a defective trace when             
calculating the contact surface normal. Check that when calculating the contact           
normal Regardless of the presence of the defective particle assembly, unless           
both components in contact have failed particles. Turn off this feature by default. 

● AutoCompute component weight 
Whether to automatically calculate the components of the contact surface normal           
calculation of the weight. When checked, it automatically sets the normal           
direction of each component's contact surface Direction of the weight, not           
checked that does not automatically set, the default is not checked. The method             
determines the weight according to the elastic modulus In Mooney Rivlin           
material, the weight is the largest, for other materials without elastic modulus is             
set to -32767, For failing components (component 0) is automatically set to            
-32768. 

● Distance type 
Sets the method of calculating the minimum contact spacing factor. 

○ distance_type = "0" means no calculation,  
○ distance_type ="1" means to calculate the nearest particle spacing of          

two objects. 
○ distance_type = "2" means to calculate the distance between two objects 

distance. distance_type = "2" if the volume of the particle is taken into             
account, since the distance_type = "1" Calculate slightly larger. 

○ Min distance set the minimum contact spacing coefficient dist. In the           
standard contact method of the material point, when two objects are on            
the same background. When the quality and momentum of the mesh           
nodes contribute, the two objects are considered to be in contact, but the             
distance between the two objects Is not zero, but less than twice the size              
of the grid cell. In order to overcome this defect, you can set the minimum               
connection 
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Touch the distance coefficient dist to determine whether contact has          
occurred. When two objects are on the same background grid node the            
quality and movement the amount of contribution and the distance          
between them is less than dist multiplied by the grid cell size, only that the               
two objects have occurred contact, Otherwise there is no contact. The           
default value of min_distance is 0.0, and no contact distance judgment is            
made. 

● Contact time step 
Whether to correct the time step of the explicit integration according to the             
contact algorithm. Check the explicit integration time according to the contact           
algorithm 
Step length correction. The default value is not corrected. The contact algorithm            
will significantly affect the critical time step of explicit integration enable this            
option. 
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● Friction coefficients - Define the coefficient of friction between materials 
 

"New" button: Defines the friction coefficient between a group of two materials. Two             
"Material" box were selected under two Material, "Coefficient" Enter the friction           
coefficient between these two materials. 
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 "Delete" button: delete the current activation of this group of friction coefficient. 
 
2.6.4 Detonation property page 

Define the initiation point / surface of the explosive and set its ignition time              
(Figure 2.55). Click "+" and "-" to expand and shrink the burst point / surface data, while                 
the item is highlighted. 

● "Add" button 
Create a new point / face 

● "Delete" button 
Deletes a currently active point / face 

● "Apply" button 
Save all the parameters in the current Detonation Points / Plans List 

● Type 
Set the type of burst / face. type = "point" means the definition of the starting                
point, type = "plane" that the definition of the starting burst face. 

● Detonation Time 
Define the ignition time of the initiation point / face 

● Detonation point 
If type = "point", you need to set the following properties:  

○ x, y, z: used to set the starting point in the global coordinate system              
position. 

● Detonation plane 
If type = "plane", you need to set the following attributes: 

○ Direction: Sets the normal of the starting surface, which is 0, 1, 2,             
respectively, corresponding to x, y and z axes; 

○ Location: Sets the position of the detonating surface on the coordinate           
axis parallel to its normal; 

○ Left: Sets the left side coordinate value of the detonating surface; 
○ Right: Sets the coordinates of the right side of the detonation surface; 
○ Bottom: Sets the bottom coordinate value of the detonation surface; 
○ Top: Sets the upper coordinate value of the detonation surface. 

 
 
 
See Figures below: 
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2.6.5 Solution Properties page 
The Solution property page (see Figure 2.56) focuses on the relevant settings for the              
solution, such as physical simulation time, time step size factor, volume update mode             
and so on.  

● EndTime 
Set the physical simulation time  

● Time step factor 
Set the time step factor, the default value is 0.9. 

● Specified 
Specify a specific time step and use this as a fixed time step when the program is                 
calculated, making it easier to compare Use, the default is not used. 

● Constant time step 
Whether a fixed time step is used 
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● MPM algorithm 
This check box is used to set the options for the solution format used in the                
calculation process: 

○ MUSL, USF, USL: These three radio boxes are used to select the            
algorithm format. By default, the "MUSL" format is used. 

○ Near Boundary Stop: Sets whether to save the restart file and exit when             
the particle approaches the boundary. Use this function. Mainly in the           
need to use the state file to restart the calculation of the case considered              
to use. 

○ Time Integration: Specifies the integration scheme used by the program.          
Select "Explicit" that uses explicit points, Select "Implicit" to use implicit           
integration. The default is explicit. The implicit integral solver is not           
complete, 
Temporarily unavailable. 

● Particle warning option: In the process of calculation, due to individual particles            
appear non-physical phenomena such as negative energy, negative volume, the          
program should be the end Only calculation. But according to the previous            
calculation experience, the individual particles of the non-physical scene will not           
affect the overall accuracy of the calculation, Therefore, the use of such a             
calculation of the first output warning message, and according to the specific            
circumstances to take appropriate measures. 

● Level: Set the warning level. The options are: "Once per timestep", "All warning             
messages", "Stop when warning, "the corresponding value range is 0,1,2, the           
default value is 0. Once per timestep (level = "0"): A warning message is output               
at each time step; All warning messages (level = "1"): A warning is issued when               
the particle variable satisfies the warning threshold; Stop when warning (level =            
"2"): Once the particle variable satisfies the warning threshold, the error is            
reported and the program is terminated. 

● Type: set the physical quantity of the monitoring, type can be "ie", "vol" or "grid",               
respectively, control the output negative energy Warning messages, negative         
volume warning messages, and mass flyout grid area warning messages. 

● Volume: 
○ Volume Update Type: Set the way to update the volume of the particle, 0              

4, the default value is "0". 
○ erode: set the erosion volume criterion, if the particle size is less than             

erode when it is eroded (ie deleted); 
○ min: set the minimum particle size correction factor, the correction is to            

limit the particle size in a certain range, the default Do not fix 
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○ max: Sets the maximum volume correction factor for the particle. The           
corrective mode is to limit the particle size to a certain range. 
Not for correction. 

○ Limit Velocity: Set the maximum speed limit for the particle. 
In the calculation process, individual particles may be abnormal, the speed           
is too large, and thus greatly reduce the time step. You can check this              
option to limit the maximum speed of the particle. 

○ Energy Fraction: Set the energy score, when the total energy error           
exceeds this score, the program will error and termination of the           
calculation. Default is not Start this control option. In the process of            
calculation, if there is no mass fly out of the grid case, the total energy               
should be guaranteed to be constant. But During the calculation, the total            
energy will change due to numerical dissipation or calculation of errors. If            
the error is due to the total, The amount of energy changes with the total               
energy ratio of more than a certain score, the program calculation results            
are not credible, then you can terminate the calculation. 

○ Dynamic Relax: Set the viscous damping coefficient 
The damping is achieved by calculating the external force of the node            
when it is proportional to the magnitude of each particle point, 
Of course, you can also use the speed of the node to introduce. The              
current setting is uniformly applied on all bodies. 

○ Gravity: Set the weight of the acceleration in three directions of the            
component, the default does not open. The unit of gravity acceleration           
depends on the current position The selected unit system, so the actual            
value of the user needs to manually convert. 

 
2.6.6 Output property page 
 
The Output property page (Figure 2.57) is used to set options for outputting the              
results, such as the console monitoring output time Separated, post-processing          
file type, post-processing observation of physical quantities. 

● Console output Set the relevant options for the console 
○ Time interval: Sets the console to calculate the status interval. The           

console monitoring content defaults to the current time, the current          
time step, the time step, the total kinetic energy, and the total            
internal energy. 

○ Momentum print: Sets whether to report momentum on the         
console. 
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● Statistics 
Statistical memory and actual grid usage. memory: whether to output          
memory at a specified time interval to .sta text This feature is currently             
only available under Windows. Check for output, do not check not output.            
The default is not output. 

○ cell_occupy: whether to output a grid of particles at a specified           
time interval to the .sta file. Check this option The output is not             
checked. The default is not output. 

● Time history output: Record the variable time-history curve of the          
observation point, and the variables that can be selected for output are            
shown in Table 2.1. 

○ "Add" button: add a watch point, the x, y, z said the observation             
point in the global coordinate system in three directions 
Coordinate. 

○ "Del" button: Deletes the currently active watchpoint. 
 

● Output variables 
Set the physical quantities to be observed in the post-processing file. The            
variables that can be selected for output are shown in Table 2.1. 

● Output format 
○ Output time interval: Defines the time interval for post-processing         

files. 
○ H5Part: whether to output H5part format post-processing data files; 
○ VTK_Data: whether to output VTK format post-processing data        

files. 
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Chapter 3 Analysis and Calculation 
 

3.1 Create an example file 
 

PeneBlast system can be generated through the following two ways to directly            
calculate the study file: 
 
(A) through the pre-processing interface in the operation, set the corresponding           
parameters to generate In accordance with the previous chapter of the interface            
function description, in the PeneBlast system pre-processing interface in the new           
definition of the task, the new material and geometric model, set the solution             
parameters, click the menu bar File-> Save Job, you can generate the current             
working path xmp file. The user can also right-click the specified task in the Job               
Browser and click "Save" to complete the operation. For details, refer to Chapter             
5, "PeneBlast Getting Started Guide". 
 
(B) directly into the existing xmp file.  
Click the menu bar File-> Load Job, the user can pop up the file dialog box                
(Figure 3.1), will specify the path of an xmp data file into the PeneBlast system               
will be loaded into the corresponding parameters, while the entity model Is            
displayed in the GUI real-time display area. The xmp file holds all the information              
entered in the pre-processing interface and can be pre-processed system          
generated, or by the user directly in the text editor to manually generate the              
generated. Users can import xmp data files. Perform a model check in the             
pre-processing interface, or reset the parameters. 
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3.2 Perform the calculation 

 
1. Before starting the calculation, click on the menu bar Simulation-> Check Input Data,              
or click the toolbar On the button to check whether the current saved xmp file conforms                
to the format requirements and gives the result of the check Error pop-up dialog box               
(Figure 3.2), given the specific error message; format is correct pop-up dialog box             
(Figure 3.3) prompt format check. 

 
 
2. Click the menu bar Simulation-> Start, you can also click the button on the toolbar,                
PeneBlast began to enter Line of the current task of the calculation (Figure 3.4). 
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3. During the calculation, the user can pause at any time as needed (Simulation->              
Pause, or click on the toolbar button) and terminate the calculation process            
(Simulation-> Stop, or click the button on the toolbar) to change the calculation real-time              
monitoring area 
The display variable. 
 
4. After the calculation process is paused, the user can click on the menu bar               
Simulation-> Save RestartFile (or click the toolbar on the button), save the restart state              
file, the program pops up as shown in Figure 3.5 dialog box, prompts to restart the file                 
save success. 
 
5. To continue the calculation from the interrupt state, click the menu bar Simulation->              
Restart, you can also click with the buttons on the bar, the PeneBlast system reads the                
last restarted state file (* .pe) state to continue to calculate (restart). 
 
6. Click the menu bar Simulation-> Postprocessing, you can also click the button on the               
toolbar, PeneBlast The system starts calling Paraview for post-processing, and the user            
will observe the results in the open Paraview interface. 
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Chapter 4 Postprocessing System 
 
PeneBlast system selection of open source software ParaView as a post-processing           
software. Since ParaView can run either on a single-processor workstation, you can            
also run a large computer in a distributed memory, so the ParaView can run either 
In a single-processing application, you can also process large data by distributing the             
data across multiple processors. For ParaView Software, PeneBlast system can          
generate two types of post-processing data files, the suffixes are vtu and H5Part. Here              
we offer a brief introduction to some of the common functions and use of ParaView, for                
a more detailed description of the function and operation process please consult            
ParaView help documentation. 
 
4.1 Start 
 
4.1.1 Installation 
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● Unix installation - According to the installation instructions recommended to          

install to / usr / local or / opt directory. 
● Windows installation - Follow the installation instructions to run the installer. 

 
4.1.2 Start ParaView 
 
There are several ways to implement ParaView, depending on whether it is running in a               
single processor mode or a distributed processor or client / server mode. Among them,              
the simplest execution mode is single processor mode. Here, we only introduce the             
single processor mode. 
 
On Unix 
If the installation path for ParaView is within the default search path of the current user                
($ PATH or $ path),  you can run ParaView with the following instructions: 

 
$ paraview 

 
If the path to ParaView does not join the current user's search path, you can add the                 
path as the default search path, or use an absolute path to run ParaView.  

 
For example, if the installation path is: / usr / local / bin, then the command in the                  

following order: 
 

$ / usr / local / bin / paraview 
 
Will let ParaView recognize the command line parameters and allow you to view the list               
of available parameters for ParaView with the -help option. 
 
On Windows 
 
Click "All Programs -> ParaView-3.8.0 -> ParaView" on the Start menu or the shortcut              
on the desktop. (For information on how to run ParaView in a distributed manner, refer               
to the ParaView help documentation.) 
 
ParaView Terms and Concepts 
Here are some of the terms used in ParaView: 

● Object: Simulates the entity state or behavior of the system. 
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● Data objects: Data abstraction. For example, when a .vtu file is loaded, the file              
passes through a data object representative. 

● Filter: A process object that requires at least one input and produces an output.              
The filter includes: flat cut, take the filter, the threshold filter and so on. 

● Pipes: In ParaView, process objects are interconnected to form a visual pipeline,            
each of the processes in the pipeline An object represents an operation on a              
data. 
 

4.2 User interface 
 
The ParaView 3.8 program interface shown in Figure 4.1, is composed of the following              
parts: 
 
Menu Bar (menu bar) 
System menu, all tasks can be done by clicking on a menu item. 
 
Tool Bar (Toolbar) 
Common tools for shortcuts collection. 
 
Pipeline Browser 
ParaView uses pipeline management data to read and operate the name of all data              
objects in the order of creation and in the form of tree structure. The sub data objects                 
are listed below each  parent data object in the order they were created. 
 
Object Inspector (object properties) 
The properties of the data objects in the pipe list, including the three attribute pages:               
Properties, Display, Information. 
 
Display Area (Display Area) 
The data visualization area of the object in the pipe list. Users can view, detect data,                
and can achieve the interaction of data manipulation. The area can be further             
subdivided into multiple different types of views and display the calculated result in             
different views. 
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4.3 A simple example 
 
Before we introduce the contents of each menu and the specific functions of the tool, we                
give a simple example of how to load a Peneblast dataset. There are two ways to get                 
data:  

1. to read data from a file or  
2. to create data with a data source object. 

We mainly use the first method to deal with PeneBlast system generated            
post-processing files (vtu and H5Part file). Suppose there is a post-processing file,            
Perforation.vtu. Click "Open" item in the "File" menu to open the file Folder, click the               
appropriate file, and then click the OK button, as shown in Figure 4.2. At this point,                
ParaView read the number 
According to the file information, a data object named Perforation will appear in the              
PipeLine Browser. Now, Click the "Apply" button on the Properties folder of the Object              
Inspector to load all the data files and the 3D view is visible (the eye icon in the pipe list                    
is black), as shown in Figure 4.3. The way data objects are drawn in the view area is                  
controlled by the Representation Toolbar of the toolbar, Type data, we use Points to              
draw the graphics, as shown in Figure 4.4, select Points; display the physical quantity              
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through the tool 
Column shortcuts Active Variable Controls drop-down menu to choose, we use the            
pressure physical volume, as shown in Figure 4.5 
Show, select the variable pres. Click to display the color label for the pressure value, as                
shown in Figure 4.6. 

Drag the mouse to move the 3D view: Press the left mouse button to move the                
mouse in the 3D View area to rotate the camera in the view area. 
The rotation of the machine is around the center of the rotation; the middle mouse               
button to move the scene; right to use to zoom in and out of the scene. 
 

4.4 Pipeline Browser 
 
ParaView uses pipe management to load data objects or other data objects that are 
generated by other methods. 
The sequence is listed in the form of a tree structure, as shown in Figure. The data 
objects in the pipe list are described as follows: 
• Data objects are the body of system processing, and each data object has three 
property pages (collectively referred to as object properties). 
 
 
Figure 4.2: ParaView opens the file 
 
 
Figure 4.3: Loading the data file 
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Figure 4.4: Select the drawing method 
 
Figure 4.5: Select the displayed variable 

 
 
Figure 4.6: Pressure at step 100 
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• A granular or haplotype object dataset can be used as a parent, and a sub-dataset can                 
be generated by a filter operation. 
• For the same object, you can display its contents in different views in different ways or                 
in different physical The amount to show.  
 

For example, the object Performation includes the calculation of some of the            
particles at each time step, and so if The object is displayed in Spread Sheet View,                
then the list of the results of the mass at each moment is obtained. 
• The object data must be activated when the data object in the pipeline is set or                 
operated. Pipeline 
A maximum of only one data object in the table is active. 
• If there is an eye icon before the data object name, the icon controls whether the data                  
object is visible in the current view. 
The pipeline area responds to the following mouse operations: 
• Left mouse button: Click the data object name to activate the data object; click the eye                 
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icon in the current 3D View 
Display the data object: gray indicates not displayed, black indicates display. 
• Right mouse button: Click the data object name or eye icon, pop up the shortcut as                 
shown in Figure? Click the blank area, 
Pop-up shortcut as shown in Figure, only Open available. 
 
 
The ParaView system supports the following sets of data sets: 
1. Quality data 
The collection of particle data, containing the coordinates of each particle and the             
calculation results, the particle data set can be created in the following way: 
 
 
2. Grid-type data sets 
A collection of grid data, a definition data containing a mesh, and a calculation result of                
a mesh node. 
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4.5 Object Inspector 
 

Each data object has object properties, including three property pages: Properties,           
Diaplay, and Information. Correct 
Like an attribute page is an important attribute of the data object that controls the data                
object: whether and how it is loaded into ParaView 
The display of the area, some basic description of the data object. Use the left mouse                
button to click on the data object in the pipe list 
The properties of the data object. Different property pages can be accessed by clicking              
on the tabs at the top of the window. 
The content depends on the current data object type. The following describes the three              
property pages. 
4.5.1 Properties 
The property page consists of two parts: Operation buttons and Parameters Setting, 
As shown in Figure 4.7. 
Operation button 
The operation buttons include three operations: 
• Apply: Click to load the current data object according to the settings of the parameter                
area. The status changes from highlight to gray. when 
When the parameter area is changed, the option is highlighted again. 
• Reset: Click to restore the last parameter settings. This item is available if the               
parameter settings have changed; 
• Delete: Deletes the current data object in the pipe list. 
Parameter area 
Different types of pipe objects, the contents of the parameter area is different, please              
refer to the specific ParaView help document. Here are three 
Parameters for typical data objects: vtu / H5Part dataset, Clip (filter operation),            
PlotSelectionOverTime 
(Filter operation). 
• vtu / H5Part file: As shown in Figure 4.8, the parameter area lists the physical                
quantities carried by the data object. The system only loads 
Check the physical quantity. 
• Clip: As shown in Figure 4.8, the parameter area lists the cut geometry definition               
parameters; 
• PlotSelectionOverTime: As shown in Figure 4.8, the parameter area lists the            
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selected list of particles and the Copy option. 
When the contents of the parameter area settings have changed, then the operation             
button Apply, and Reset will be highlighted, click Apply 
Button settings will take effect, click the Reset button to restore the previous settings. 
 

 
Figure 4.7: Parameter settings property page 
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4.5.2 Display 
The property page is used to set some parameters that control the pipe object when the                
view area is displayed, consisting of multiple sub-property boxes. Do not 
The contents and number of the pipe sub-attribute box of the same type have changed.               
Only the data object and its view are selected 
, The property page is available. The following describes the two typical data object              
Display property page: vtu / H5Part 
Data set and PlotSelectionOverTime (filter operation). 
vtu / H5Part file 
The data object's property page consists of 10 sub-attribute boxes: View, Color, Slice,             
Annotation, Style, Edge 
Style, Volume, Lighting, BackfaceStyle, Transformation. The following describes the         
Style property box, 
Please refer to the ParaView help documentation for other information. The Style            
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property box is used to control the size of the displayed particles, as shown in Figure                
4.9. 
The meaning of each option is as follows: 
• Representation 
Function: Select the mapping method, pure point type data recommended use Points,            
containing the unit is selected Surface With 
Edges. 
• Interpolation 
Function: Select the interpolation method for drawing the cloud. 
• Material 
Function: Please refer to the ParaView help documentation 

 
 
• Point size 
Function: Adjust the displayed particle size. 
• Line width 
Function: Adjust the width of the display unit edge. 
• Opacity 
Function: Adjust transparency. 
• Volume mapper 
Function: Please refer to the ParaView help documentation. 
PlotSelectionOverTime 
The attribute page of the data object consists of eight sub-attributes: Select Block,             
Attribute Mode, X Axis Data, Line 
Series, Line Color, Line Thickness, Line Style, Marker Style, as shown. The following is              
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a brief introduction 
Under Select Block, X Axis Date, Line Series property box. Please refer to the ParaView               
help documentation for other information. 
• Select Block: The list of observed particle IDs, the time curve for the selected physical                
quantities of the particles in XY 
Plot View show. The place can only be selected. 
• X Axis Data: Select the contents of the x-axis 
• Line Series: A list of physical quantities. 

 

4.5.3 Information 
The property page displays some statistics for the pipe object. For different types of data               
objects, the contents of the property page will be 
Different. Here we only give the introduction of the imported particle data created by the relevant                
content of the pipeline object. Other please 
Refer to the ParaView help documentation. For a pipe object with particle / unit data, the                
properties page is shown in Figure 4.11. 
Specifically includes five items, as follows: 
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●  Properties: Displays the filename of the current frame of the pipe object and the 
path where the file is saved.  

● Statistics: Displays some statistics for the pipe object, such as data type, number 
of cells, number of points, file size.  

●  Data Arrays Function: Displays the data type of the physical quantity in the 
current frame and the range of the physical value  

●  Bounds Function: Displays the boundaries of the material area in the current 
frame  

● Time function: Refer to the ParaView help file 
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4.6 drop-down menu 
 
4.6.1 File menu 
The File menu is mainly used to open and save ParaView various types of files. 

● Open 
Function: Open the data file. PeneBlast's results are stored in H5Part or vtu's 
data format In the H5Part as a file, and vtu file is composed of multiple files, the 
file corresponds to an output step.ParaView can load a file, you can also load a 
series of vtu files, the formation of animation. 
 

○ Process: Click this option to bring up the file selection dialog (shown in 
Figure 4.2). Select the file you want to open -> Object 
Browser to add the file name named object -> Object Inspector show 
Properites property page, 
Lists the result variable names contained in the data file, and the user can 
select the results to be processed. 
The Apply button in the page, the physical model of the first time step will 
be displayed in the current view (if the current view 
Not the 3D View view, it is not displayed). 
 

● Recent Files feature: Open recently opened files. 
 

○ Process: Click this option to list the recently opened list of files in the form 
of a submenu under this menu item. 
Select the file name in the table, the system according to the file extension 
to determine the open mode. 
 

●  Save State 
 

○ Function: Save the current GUI status and all data sets of the ParaView to 
a file (with the extension sta), 
With Load State, you can restore the ParaView to the saved state 
(including the GUI interface and all datasets). 

● Load State 
Function: read the saved ParaView state from the sta file and restore the 

79 
 
 
 
 



 

ParaView to that state. In the case of 
 

● Save Screenshot 
Function: Saves a screenshot of the current view. 
 

○ Process: Click this option to pop up the file selection dialog box to select 
the file type to be saved (png, tif, bmp, jpg, pdf) 
-> Save the snapshot of the current view in the specified format to the file. 
Save Screenshot can not be used with Spreadsheet 
View view (the menu item will be grayed out). 
 

● Save Animation 
Function: save the animation. 
Process: Click this option to bring up the Animation Settings dialog box, as 
shown in Figure 4.12. In the dialog box, click Save Animaiton, the pop-up dialog 
box, as shown in Figure 4.13. You can choose to save the format 
(avi, jpg, png, pdf, etc.), Paul 
Save the path and edit the file name, the time display area of the snapshot is 
saved in the specified format. Only when it has been opened 
Post-processing data files (vtu / H5Part format) are available. If you choose avi 
format, save as an animation, if selected 
Select the picture format, then save each frame as a picture. 

● Exit 
Function: Exit the program. 
Process: The confirmation dialog box pops up -> Ok or Cancel. 

●  Load State 
Function: read the saved ParaView state from the sta file and restore the 
ParaView to that state. In the case of 

● Save Screenshot 
Function: Saves a screenshot of the current view. 
Process: Click this option to pop up the file selection dialog box to select the file 
type to be saved (png, tif, bmp, jpg, pdf) 
-> Save the snapshot of the current view in the specified format to the file. Save 
Screenshot can not be used with Spreadsheet 
View view (the menu item will be grayed out). 

● Save Animation 
Function: save the animation. 
Process: Click this option to bring up the Animation Settings dialog box, as 
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shown in Figure 4.12. In the dialog box, click Save Animaiton, the pop-up dialog 
box, as shown in Figure 4.13. You can choose to save the format 
(avi, jpg, png, pdf, etc.), Paul 
Save the path and edit the file name, the time display area of the snapshot is 
saved in the specified format. Only when it has been opened 
Post-processing data files (vtu / H5Part format) are available. If you choose avi 
format, save as an animation, if selected 
Select the picture format, then save each frame as a picture. 
 

● Exit 
Function: Exit the program. 
Process: The confirmation dialog box pops up -> Ok or Cancel. 

  
● Setting 

Function: Set the global parameters of the program. Click this option to bring up 
the Settings dialog box, as shown in Figure 4.14 (on the left 
The setting of each category, the right part of the settings for the details) shown. 

● ViewSetting 
Function: lists the contents of the current view can be changed, the 
corresponding content will be based on different types of views are different. 
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4.6.3 View menu 
 
This menu is used to customize the shortcuts on the ParaView toolbar, such as animation 
controls, pipe lists, object properties pages 
Wait. 
 

● ToolBars 
Function: control the tool bar shows the shortcut, click on its subordinate menu of an 
item to switch the item in the tool 
Column shows / hides the status as shown in Figure 4.15. 
 

● Annimation View 
Function: Controls whether the animation playback status control bar is displayed on the 
interface. 
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Chapter 5 PeneBlast Getting Started Guide 
In order to facilitate learning to use the PeneBlast system as soon as possible, this chapter 
through a few examples of the software in detail 
The process, in which the modeling, solution and post-processing of the oblique invasion are 
described. In addition, it is provided 
Taylor rod, two-dimensional TNT detonation, broken, steel ball penetration of concrete, Gurney 
flyer, jitter jets, they 
From the study description, task definition, material definition, component settings, grid settings, 
contact settings, detonation settings, 
Set the output settings, check the modified input file and calculate the monitoring of several 
parts of the PeneBlast system in the specific instances. 
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5.1 Guide to Diagonal Penetration Model 

 
5.1.1 Model Overview 
The example simulates a kinetic energy bomb with an initial velocity of 575 m / s penetrating an 
aluminum plate for the study of kinetic energ performance, more concerned about the kinetic 
energy bullets before and after the speed of armor. The kinetic energy is a cylinder with an oval 
warhead, the material is steel, 
The target material is aluminum. The corresponding size of the study model is: 

1. The diameter of the cylindrical part of the projectile is 12mm, the length is 89mm, the 
radius of the oval warhead is 6mm, the appearance 
Surface radius of 18mm; 

2. The thickness of the target is 26mm, 96mm long and 100mm wide; 
3. Projectile with a target angle of 30 degrees. 

 
In this example, the unit system uses mm ms g 
 
The model diagram is shown in Figure 5.1. : 
 
 
(No picture in original manual for fig 5.1*) 
 
Material parameters 
According to the test situation, under normal circumstances, the wear of the missile is relatively 
less, and the damage of the target is very serious. So in the calculation 
The material model used for each object in the simulation is shown below: 
1. The elastomeric model of the elastomer is in the MPM3DPP program, and the IsoHarden 
material 
The parameter value is shown in Fig. 
2. The Johnson-Cook model is used for the target model, the state equation is Gruneisen's state 
equation, the failure is maximum, etc. 
The plastic strain model PlaStrain, the corresponding parameter values are shown in Fig. 
Modeling method 
Specific modeling process has the following key considerations: 
1. The model has a symmetry shape, in order to improve the computational efficiency, it is 
desirable to model half of the model; 
2. As the pre-processing can not be generated once the missile body, so the half of the missile 
model to be generated separately, that is, the first half 
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Cylindrical body, and then the establishment of half of the oval body, thus the two body 
synthetic elastomer model; 
 
 
3. Since it is not possible to directly generate a tilted rectangular parallelepiped, it is 
necessary to define a translation plane or work plane after the translation, and then 
The target plane is established in this work plane (local coordinate system); 
4. The study should enable the contact algorithm, so to establish two components, the 
above-mentioned discrete parts are classified into the corresponding components; 
5. In this example, the background grid size is taken as 2 × 2 × 2mm and the particle 
distance is 1mm. 
Summary of steps 
The flow of the study is divided into three parts, the first part is pre-processing, used to 
generate MPM3DPP program can read 
* .xmp file; the second part with the Peneblast system call MPM3DPP program to read 
the corresponding data file and 
Line calculation; the third part of the post-processing, the use of Paraview generated 
data files for a variety of data processing. The following Jane 
To list the steps. 
 
Pretreatment 
 

1. Specify the working path, task name, unit system; 
2. Define the material model 
3. Establish discrete models 
4. Define the background grid 
5. Define the contact algorithm 
6.  Specify the output options 
7.  Specify the Solver option 
8. output definition file 

 
Solve the calculation 
 

1. set the execution control 
2. Perform the calculation 
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Postprocessing 
 

1.  Read the results of the solution 
2. animated presentation 
3. Select the particle 
4. slices, cut, view the internal particles 

 

5.1.2 Pretreatment 
Step 1 Specify the working path, task name, and unit system 
The function of the pre-processing is to define the input file for the MPM3DPP program to read, 
so it is generally necessary to specify a file for the file 
Save the path, the file name, and some simple descriptions of the study; you also need to 
specify the unit used to solve the problem 
system. Open the Peneblast program and edit the Job Properties of Job1 in the Job Browser, as 
shown in Figure 5.2. 

 
Step 2 Define the material model 
In this paper, the definition of the study of all the material model, the material model is 
defined in a variety of ways, can be used directly 
Materials have the material, modify the material in the material library as a new material 
or directly create a new material. In this study only 
Using two kinds of material model, in this new way to define, the following one by one. 
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1.  Models-> Material pops up as shown in Figure 5.3; 

 
2. Click New to display the dialog box shown in Figure 5.4. 

Here you can specify the material name, density, intensity model, state equation 
and failure parameters such as value. Respectively, with the corresponding 
under 
Pull the menu to find the use of the material model, fill in the corresponding 
material parameters can be completed, click the button after filling 
The parameter value should be read, exit the upper left corner, cancel the current 
settings click button. For this example 
The two material models are filled in Figure 5.5 and Figure 5.6 below. 
 

Step 3 Defines the discrete model 
 
For this example, you need to create two components to enable the touch algorithm. 
The missile is set as the component projectile, the target is set to 
The component target, each discrete model, needs to be generated under the specified 
component. The establishment of the missile body is slightly complicated due to the 
projectile 
For the oval shells, need to establish a separate body and warheads. As long as the 
warheads and bones of the discrete particles at the recent interval of not more than a 
net 
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The size of the grid is considered to be one of the two. Because of the symmetry of the 
problem, it is only necessary to build half the model. 
 

1. Build the component projectile 
Can be built through the toolbar Models-> Create Component or right-click 
PreDataSet to select New 
The components are shown in Figures 5.7 (a) and 5.7 (b), respectively. In the 
PreDataSet appears component1, double-click component1 
Modify it to projectitle. 

2. Create bones in the component projectile Guidelines for Diagonal Invasion. The 
bomb is a cylinder, where half of the model is created. 

a.  Select projectitle 
b. Click Models-> Create Cylinder, or right click PreDataSet to select New 

Cylinder and Create a cylinder, as shown in Figure 5.8 (a) and Figure 5.8 
(b). After the interface on the left side of the interface shown in Figure 5.9, 
is divided into three parts. The first part of the Properties property page 
Used to fill in the geometric information, the second part of the Load 
Setting property page is used to set the load parameters, the third part of 
the Display 
The page is used to set the display parameters, the fourth part of the 
Discretization property page is used to set the discrete parameters. 

c.  fill in the Properties page attribute value, as shown in Figure 5.9 below. 
in the size box to fill out the geometric information, the specific meaning of 
the manual; 

d.  in the Velocity box to specify the initial speed of the object, this time the 
target body in the top of the body, so as shown in Figure 5.9; 

e. in material Specifies that the object's material model is Steel; 
f. Click the Discretization button to make discrete settings, which are mainly 

used for particle spacing settings, as follows In Figure 5.10; the body 
model is shown in Figure 5.11. 

3. Under the component projectile, establish a semi-oval body discrete model. 
a. with the left mouse button click projectitle, select the component; 
b. Click Models-> Create Ogive, or right click PreDataSet to select New 

Cylinder to create Oval, as shown in Figure 5.12 (a) and Figure 5.12 (b). 
c. fill in the Properties page attribute value, as shown in Figure 5.13 below. 
d. Click the Discretization button to make a discrete property page for 

discrete parameter settings, as shown in Figure 5.10. 
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The same situation. The warhead model established is shown in Figure 
5.14 

4. Left click on the component projectile to see half of the model of the complete 
projectile on the right side of the window, as in Fig 5.15 (trivial) 

5. Build component 
Since this example simulates oblique penetration, the target plane needs to be 
used in the work plane, first in the PreDataSet property page 
WorkPlane defines the work plane, as shown in Figure 5.16. Define the work 
plane WorkPlane1, see Table 5.1 for specific parameters 
See the MPM3D User's Manual for parameter details. 

6. Models-> Create Component, or right-click PreDataSet to select New to create 
the target component 
Component2 appears under PreDataSet and double-click component2 to change 
it to target. 
6. Build the target model under the component target 
6.1 selected components target: 
6.2 Click Models-> Create Block or right click on to select New Block to create 
the box, 
In this case, the property page of Block is displayed on the left side of the 
window, as shown in Figure 5.17. 
6.3 Click Properties to enter the property page for geometric parameter setting 
and initial speed setting, as shown in Figure 5.17. 
6.3.1 fill in the Block size box geometry information; 
6.3.2 Select WorkPlane1 in the WorkPlane drop-down box; 
6.3.3 Select the Aluminum material in the material box; 
6.3.4 Velocity check box is not checked; 
6.4 Click the Discretization tab to enter the parameter page to set the parameter 
discrete parameter, where dp is 1, with 
The discrete process is automatically calculated. The settings are shown in 
Figure 5.18.The resulting target is shown in Figure 5.19. 
At this point, the discrete model has been completed, click PreDataBase to see 
the overall model shown in Figure 5.20, the following into 
Into the PreDataBase property page settings. 

7.  
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5.15 Projectile model; 5.16 
Define the work plane 
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5.17 Property Page Settings  
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Step 4 Set the background grid 
 
In principle, the background mesh as a range of motion that should completely cover 
the object within the simulated physical time. If used to move 
Dynamic grid, depending on the circumstances at least cover the initial time occupied 
by the object space position. This example, in this dynamic grid, 
The mesh area covers the motion range of the object. In this case, should also set the 
corresponding boundary conditions, and whether to use GIMP shape function. details 
as follows. 
4.1. Click the PreDataSet on the left side of the window, where Job Properties can be 
set for the Grid, 
Click on the Grid to enter the background grid settings page, according to the specific 
circumstances of this study, the corresponding border size and border conditions with 
The body settings are shown in Figure 5.21. 
 
4.2 Set the background mesh discrete size on the Grid property page, as shown in 
Table 5.2. 
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4.3 Set the grid spacing to 2 × 2 × 2 on the Grid property page 
4.4 Set the dynamic grid on the Grid property page to save memory when calculating, 
as shown in Figure 5.22 
 
 
Figure 5.22: Dynamic Grid Settings 

 
 
At this point, the background grid of the relevant parameters according to the specific 
circumstances of this study have been successfully set up. 
 
 

Step 5 Turn on the contact algorithm 
 
This example establishes two components, with the touch-enabled algorithm. So the 
pre-processing need to open the contact function; the current example 
Does not consider friction. 
 
Click Contact to enter the relevant parameter settings page, as shown in Figure 5.23. 
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In addition, manually set the weight of the missile and target contact algorithm 
calculation, respectively, select the components projectitle and target, in the respective 
Component Properties under the settings, where the weight of the body is bigger, the 
missile body and the target 
The weight settings are shown in Figure 5.24 (a) and Figure 5.24 (b), respectively. 
 

Step 6 Set the output options 
 
In this case, set the physical quantity to be observed in the post-processing file, the 
number of output files, and the time of the console monitoring Separated 
6.1 Click the Output button to enter the corresponding property page, as shown in 
Figure 5.25; 
6.2 Set the console output value. For the current example, the setting is shown in Figure 
5.25. 
6.3 Select the physical quantity to be observed, and check it in the box in front of it. For 
the example, see Figure 5.26. 
6.4 Select the output file format, and the output time interval, for the study set Figure 
5.26; 
At this point, the output options for this study are set. 
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Step 7 Set the Solver option 
 
Here, we set some settings for solving, and the application of gravity field. 
 
7.1 Click the Solution button to enter the property page, as shown in Figure 5.27; 
7.2 Set the simulated physical time End time to 0.8 and the time step factor is 0.2 
The settings of this study are shown in Figure 5.27; 

 
 
7.3 Set the MPM algorithm, for the study, select the MUSL format; 
At this point, the options for the solution are set up. 
 
Step 8 Save the input file 
 
The above seven steps constitute the basic steps of the pre-processing of this example, 
and the work is saved to the MPM3DPP program. 
Enough to read the suffix for the xmp file. 
Click File-> Save Job, save the file to the current working path, as shown in Figure 5.28, 
generate OgiveProjectitleImpact.xmp 
Enter the file. Also you can right-click the task in the Job Browser and select Save to do 
this. 
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Click Simulation-> check Input Data to check the input file, pop-up dialog box, as shown 
in Figure 5.31 
You Must check xmp through format check prior to solving. 
 

5.1.3 Solving calculations 

 
Step 10- perform the calculation 
 
1. Simulation-> Real time monitor Turns on real-time monitoring. 
2. Toolbar-> Start, perform the calculation, calculate the monitoring screen as shown in 
Figure 5.32. 
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3. During the calculation, you can pause, terminate the calculation process and change 
the XY Plot variable. 
4. After the calculation process is paused, click Save Restart Files to save the restart 
status file. 
5. If you continue to calculate from the interrupt state, in the option interface to load the 
restart state file, if you want to restart the command file(* .rmp), set together. 
 

Step 11 Read the solution 
 
Use Paraview software for post-processing, read and solve the output file 
Menu-> File-> Open Load the resulting file, as shown in Figure 5.33. 
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1. Press the work button on the toolbar to view the tip of the projectile, as shown in 
Figure 5.34. 

 
 
2. In the Variable check box, select fail to check the URL failure status, as shown in 
Figure 5.35. 
3. Select the point using Select Points Through. Then select Extract Delection from the 
Filter menu and click on the Properties page 
Copy Active Selection to get the selected particle. 
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3. Select the point using Select Points Through. Then select Extract Delection from the 
Filter menu and click on the Properties page 
Copy Active Selection to get the selected particle. 
 
 
 
 
 
 
 
 
 
 
 
The Spreadsheet view is an important tool for connecting data selection and numerical 
analysis. It allows the user to view the scalar domain 
The actual value of the selection mechanism to help users identify the value of interest. 
Use or divide the view into two halves. 
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In the new view, click the "Spreadsheet View" button to monitor the selected data set, 
click to make the number 
As shown in Figure 5.36, the operation examples are shown in Figure 5.36. 
 
 
 
 
 
4. Paraview has the ability to draw time series field graphs. Drawing operations are 
based on data selection Row.  
First select the data set, click the menu Filters-> Data Analysis-> Plot Selection Over 
Time, 
In the Object Inspector, click "Copy Active Selection", and finally click to get the 
selected 
The time-history curve of the particle-dependent variables, as shown in Figure 5.37. 
5. Slice, cut, view internal points. 
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